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11..    IINNTTRROODDUUCCTTIIOONN 
 
Thank you for choosing an Astro-Med data acquisition recorder.  This Quick Start Guide was prepared to help you 
become acquainted with your Dash 2EZ+ recorder as quickly as possible. We include sample examples and exercises 
throughout this Quickstart guide so you can become familiar with the basic operation of the unit.   
 
The Dash 2EZ+ is a powerful and versatile hand-held data acquisition system with integrated chart recorder that provides 
the capability to display, record, review and print waveform data.  
 
Data samples can be acquired at rates up to 40,000 samples per second per channel and streamed directly to a 
CompactFlash® card (2 GB maximum).  
 
The Dash 2EZ+ utilizes a touch-screen as the main user interface. Many of the Dash 2EZ+ control icons are 
customizable, providing the capability to modify the display based on the needs of the user or application. 
 
Please note that the Dash 2EZ+ has much more capability than presented in this Quickstart guide. The Dash 2EZ+ 
Operations Manual (Part Number 22834552) can provide additional details. 
 

22..    HHAARRDDWWAARREE  OOVVEERRVVIIEEWW  
 

The following is a summary of the location of the physical components of the Dash 2EZ+.   
 

Front View: 
 

 

Touch-screen: The touch-screen serves as the user interface for the Dash 2EZ+. On-screen 
menus and icons can be selected by touching the display. Alternatively, a stylus may be used to 
select on-screen menus and icons. 

 
 
 
 
 
 

Left Side View: 
 

 

Serial port: The serial port is not currently used. 
 
USB 2.0 port: The USB 2.0 port is used to transfer data capture files to a PC. For more 
information, refer to Analyzing data capture files on a PC with AstroVIEW X in the Dash 2EZ+ 
Operations Manual Chapter 8. 
 
Event phone jack input: The event phone jack input provides the capability to mark an event 
using an outside signal. Event signals have a high state (switch open) and a low state (switch 
closed), and are TTL and switch closure compatible. 
 
Trigger phone jack input: The trigger phone jack input provides the capability to invoke a trigger 
using an outside signal. A falling edge or switch closure on this line will cause an external trigger. 
 
Ethernet port (10/100 Mbps): The 10/100 Mbps Ethernet port is used to transfer data capture 
files to a PC. For more information, refer to Analyzing data capture files on a PC with 
AstroVIEW X in the Dash 2EZ+ Operations Manual Chapter 8. 
 
CompactFlash drive: CompactFlash cards (2 MB maximum) are used to accomplish the saving 
and loading of setup files along with the recording (capturing) and reviewing of data capture files. 
 
You can insert and remove CompactFlash cards while the Dash 2EZ+ power is on or off. To insert 
a CompactFlash card, slide the card into the CompactFlash drive slot. Gently press the card to set 
it into place. To remove the card, gently pull it out from the CompactFlash drive slot. 
 
Note: Before the Dash 2EZ+ can save data or setup files, the CompactFlash card must be 
formatted. Instructions on formatting the CompactFlash card are presented in the Sample 
Exercise section 13 of this Quick Start guide. 
 

Continued…



Right Side View: 
 
 

 
Power switch: The power switch is used to power-up and power-down the Dash 2EZ+. The 
power-up sequence requires less than one minute. 
 
Power inlet: The power input is used to connect the power cord to the Dash 2EZ+. 
 
Power indicator light: The power indicator light is used to visually indicate the power status of the 
Dash 2EZ+. When the unit is operating, this indicator will remain lit. 
 
Stylus: The stylus can be used to select on-screen menus and icons. To remove the stylus, slide it 
out of the built-in holder. 

Back Side View 
 
Paper door: The paper door provides access to the strip chart recorder paper. 
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33..    GGEETTTTIINNGG  SSTTAARRTTEEDD  
 
Voltage Verification: The Dash 2EZ+ comes with an external power supply that operates from 102 – 264 VAC at 50 or 
60 Hz. You do not have to set up any fuse block arrangement. 
 
Connect AC Power Cord: Connect AC power cord to the side panel, then to an outlet. The Dash 2EZ+ has an internal 
rechargeable Lithium Ion battery; it takes four hours to completely charge the battery. The battery provides approximately 
1.5 hours of use; this may vary based on the functions used. For example, constant printing will use more battery power 
than viewing data. The unit will operate from AC power when plugged in. The unit does not need to be powered on to 
charge the battery. 

 Battery Type   Lithium Ion (rechargeable)  
 Charge Time   4 hours

 Input Voltage Range   9-24 VDC (> 14 VDC required for battery charging)  
 Power Consumption   35 W Max (15 W typ with chart halted)  

 BATTERY POWER

 Battery Life  

 POWER

 1.5 hours (capturing to CF card) 
 60 min (printing at 5 mm/s)

 
 
Load Chart Recorder Paper: Please see Chapter 2 of the Dash 2EZ+ Operations Manual for detailed instructions on 
loading Dash 2EZ+ chart paper. 
 
Turn On the Dash 2EZ+: When you turn on the Dash 2EZ+ using the power switch located on the right hand side of the 
unit, the display will show various initialization screens and then load the default setup programmed on the unit. 
 
Display: The Dash 2EZ+ has a 5.7” touchscreen display.  The display is divided into two main areas, the Waveform 
Display Area (shows the waveform signals typically drawn onto a grid pattern) and the Control Panel (rows of control 
icons for operation). 
                       

Waveform 
Display 

Area

Control 
Panel

 
 

Dash 2EZ+ Screen with waveforms and Control Panel 
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4.4.  CONTROL  PANEL  ICONS  CONTROL PANEL ICONS
  
CONTROL PANEL The Control Panel is a customizable group of icons located on the right side of the display. It can 

provide immediate access to virtually any function with one touch. Each mode of operation 
(Realtime and Review) utilizes its own customizable control panel. 

 
The ACTION on the left-hand side describes the function. 
The HOW TO section provides the detailed steps to take using the Dash 2EZ+ Control Panel and Menu. 

  
ACTION HOW TO  (Customize the Control Panel)  
   
Add and Remove 
icons to/from the 
Control Panel 
 

 
 

Menu Icon 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Control Panel Icon 

To customize the control panel: 
1. Choose the Menu icon. The Menu icon is located at the top right hand side of the D2EZ+ 
touchscreen. The main Menu screen will open.  
  

 
 

Choose the Control Panel icon is located on the bottom left hand side of the Menu screen. The 
Control Panel Setup screen will open. 
 

 
 
The icon list on the left provides functions that can be added to the Control Panel. The columns 
on the right display the layout of the control panel. There are 16 icon slots in the Control Panel. 
You can customize up to 15 of these icons; the upper-right icon slot is reserved for the Menu 
icon. 
 

2. To add icons, select a function from the icon list on the left. Then choose a control panel icon 
slot. An icon for the chosen function will appear in the selected control panel location. If the 
location previously contained an icon, the icon will be replaced. 
 

3. To remove icons, select the No Function block from the icon list on the left. Then choose a 
Control Panel icon slot. Note: The Menu icon cannot be removed or replaced. 
 

4. Choose OK to complete the Control Panel customization. 
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55..    UUSSIINNGG  TTHHEE  DDAASSHH  22EEZZ++  
 

The Dash 2EZ+ has two modes of operation, Realtime, and Review modes. 
 
Realtime Mode: The Dash 2EZ+ Realtime mode is the default mode for the Dash 2EZ+. Realtime mode provides real-
time waveform scrolling, monitoring, and data capture capabilities. The following illustration displays a typical screen 
during Realtime recording. Screen appearances will vary based on icon configurations and other selected options. 
 

 
 

Layout of the Dash 2EZ+ Realtime Mode Screen 
 

(1) Channel 1 Status Area or Cursor Information or Meter Reading 
(2) Waveform Display Area 
(3) Channel 2 Status Area or Cursor Information or Meter Reading 
(4) Date and Time Indicator 
(5) Chart Speed Indicator 
(6) Trigger Indicator 
(7) Customizable Control Panel (16 Icons Max) 

 
The ACTION on the left-hand side describes the function. 
The HOW TO section provides the detailed steps to take using the Dash 2EZ+ Control Panel and Menu. 

 
ACTION HOW TO  (Enter Realtime Mode from the Main Menu)  
Enter 
Realtime 
Mode 
 

 
 

Menu Icon 
 

 
 

Go to 
Realtime 

Icon 

The following are instructions to enter Realtime mode from the main Menu. These instructions also apply 
to accessing the Amplifier Setup, View Setup, Capture Setup, Trigger Setup, Control Panel, System 
Setup, Go to Realtime, Go to Review, Save and Load Setup menus from the main Menu. 
 
1) Choose the Menu icon. The Menu icon is located at the top right hand side of the D2EZ+ touchscreen. 
The Menu screen will open. 
 
 
 
 
2) Choose the Go to Realtime icon located in the top right hand corner of the Main Menu under the 
System Setup icon. Realtime mode will open. 
 
 
 

Continued…



Review Mode: The Dash 2EZ+ data capture Review mode provides the capability to review and analyze saved data 
captures. The following illustration displays a typical screen during review. Screen appearances will vary based on icon 
configurations and other selected options. 
 

 
 

Layout of the Dash 2EZ+ Review Mode Screen 
 

(1) Channel 1 Status Area or Cursor Information or Meter Reading 
(2) Waveform Display Area 
(3) Channel 2 Status Area, Cursor Information or Meter Reading 
(4) Cursor or Left side Measurement 
(5) View data capture name, time/division, or print menu 
(6) Scroll Bar 
(7) Cursor or Right side Measurement 
(8) Compression / Expansion 
(9) Customizable Control Panel (16 icons max)          

 
Note: A basic hands-on Review Mode lesson is part of the Sample Exercise covered in section 13 of this 

QuickStart Guide. 
 
  
  
  
  
  
  
  
  
  
  
  
  
  
  

 7

  



 8

66..  AAMMPPLLIIFFIIEERR  SSEETTUUPP  
 

The Amplifier Setup menu allows the user to set the span for the channel and to adjust the zero volt position. Each 
factory installed module type (HV-EZ+, Isolated Voltage module and/or BR-EZ+ Isolated Differential Voltage Bridge 
Module) have unique amplifier settings. The BR-EZ+ module also provides up to 10V excitation for bridge sensors. 
Excitation for the BR-EZ+ is set in the Amplifier tab of the Amplifier Setup menu. 
 
The Dash 2EZ+ can be purchased with either two factory installed HV-EZ+, Isolated Voltage modules, two BR-EZ+ 
Isolated Differential Voltage Bridge Module or one of each. 
 
The Dash 2EZ+ Amplifier setup also contains signal Filter selections. Further, user scaling is supported on the Dash 
2EZ+ so that your channels can report their values to you in Engineering Units. Alarms can be set that will change the 
color of the displayed waveform (screen only) when is passes through a pre-defined level. The selection tabs at the top of 
the Amplifier Setup menu allow the user easy access to all of the Amplifier Setup features. 
 

HV-EZ+
Amp 
Setup

BR-EZ+
Amp 
Setup

User Defined Channel Labels

Main Menu/Amplifier Setup

Filter 
Selections

Selection 
Tabs

 
 

High and Low alarms can be enabled and set for Channels 
1 & 2. Alarm colors are defined in the “View” menu.  

 
The Filter, Amplifier and Alarms sections of the Dash 2EZ+ Amplifier Setup Menu 

 
Note: A basic hands-on Amplifier Setup lesson is part of the Sample Exercise covered in section 13 of this 

QuickStart Guide. An example of entering Engineering Units is presented in section 12. 
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77..  VVIIEEWW  SSEETTUUPP  
 

The View Setup menu allows the user to set the grid and waveform display. The Format tab gives the user the ability to 
customize the Grid and Event styles along with the chart Speed (Chart speed icons can be placed on the Control 
Panel). The Colors tab is used to assign waveform colors and alarm conditions. The Measure tab gives Realtime and 
Review cursor measurements (Maximum-Minimum, Average, Peak to Peak, Slope, RMS, Samples, Absolute Time 
and Relative Time).  
 

User selectable 
colors 

(display only) 
for waveforms, 
alarms and over 

range 
conditions.

User selectable 
grid setup allows 
grid overlap for 

quick signal 
comparison and 

customizable grid 
layout

Main Menu/View Setup

Selection 
Tabs

Print Darkness 
Adjustment  

 

User Selectable 
Cursor & Time Measurements

Maximum – Minimum
Average

Peak to Peak
Slope

Root Mean Square
Samples

Absolute Time
Relative Time

System Text and Channel Text 
Buffers 

(Prints on Chart Paper Only!)

 
  

The Format, Colors, Measure and Text sections of the Dash 2EZ+ View Menu 



 10

88..  CCAAPPTTUURREE  SSEETTUUPP  
 
The Dash 2EZ+ Capture Setup allows the user to customize the recording of data to fit various applications. The 
Channel Enable section provides the interface to enable or disable Channel 1, Channel 2 or the Event channel in the 
recording. The Base Filename of the record can be assigned along with the data capture length and Sample Rate. 
 
The user can Arm and Abort data captures from the Capture Setup menu. The capture Arm and Abort icons can also 
be placed on the Dash 2EZ+ Control Panel. 
 
Note: Before the user can input Capture Setup functions or capture data, a formatted CompactFlash card must be 
inserted. A basic data capture setup along with instructions on formatting the CompactFlash card are presented 
in the Sample Exercise section 13 of this Quick Start guide. 

  

Add/Remove Channel 
from Data Capture

User Defined 
Data Capture file name

Sample Rate selection 
pull down menu

Enable/Disable 
Software/Hardware 

Triggering

Automatically Rearm 
or Review data capture 

after completion of 
capture

Arm and Abort Data 
Capture

Note: Both of these icons 
can be placed on the 

Control Panel.

Main Menu/Capture Setup

Data Capture length 
pull down menu

  
  

The  Dash 2EZ+ Capture Setup Menu 
  

Note: A basic data capture setup is presented in the Sample Exercise found in section 13 of this QuickStart 
Guide. 
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99..  TTRRIIGGGGEERR  SSEETTUUPP  
  

Triggers are user-defined events that initiate the post-trigger data capture process. The Dash 2EZ+ Trigger Setup menu 
provides various Analog and Clock trigger types.  
 
Analog Channel Triggers 
 

Manual - Manual is a commonly used method that allows the operator to initiate a trigger manually via the control panel.  
 

External - External uses an external signal via the trigger phone jack to produce a trigger. The external signal is a switch 
closure to ground or TTL low to produce a trigger. Process control signals can be used to produce this trigger.  
 

Rising - Rising produces a trigger when signals cross above a user-defined level.  
 

Falling - Falling produces a trigger when signals cross below a user-defined level.  
 

Rising or Falling - Rising or Falling produces a trigger when signals cross above or below a user-defined level. 
 

Above - Above produces a trigger when signals are above a user-defined level.  The trigger condition is in place as long 
as the signal stays above the level.  
 

Below - Below produces a trigger when signals are above a user-defined level.  The trigger condition is in place as long 
as the signal stays above the level.  
 

Outside - Outside produces a trigger while signals are outside of the user-defined high and low window limits.   
This method is exclusive of high and low settings. 
 

Inside - Inside produces a trigger while signals are inside of the user-defined high and low window limits.   
This method is inclusive of high and low settings. 
  
Clock Triggers 
 

Periodic - Periodic produces a trigger after a specific amount of elapsed time. When the trigger occurs, this process will 
be repeated.  
 

Time - Time produces a trigger at a specific date and time. 
  

Main Menu/Trigger Setup

Periodic Trigger Setting

Time Trigger Setting

Analog Trigger Settings

  
  

The Dash 2EZ+ Trigger Setup Menu 
 

Note: A basic analog trigger setup is presented in the Sample Exercise found in section 13 of this  
QuickStart Guide 
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1100..  SSAAVVIINNGG  //  LLOOAADDIINNGG  SSYYSSTTEEMM  SSEETTTTIINNGGSS  
  

The Dash 2EZ+ can save user configured setup files for Realtime, Control Panel, Trigger and Capture settings. These 
setting can be saved separately or together as one Global file. 
 
Global setting files contain all system setup information that can be saved for later recall. These files can be considered a 
"complete setup” that can be saved and loaded as needed. 
 
The Dash 2EZ+ does not automatically save the latest setup when the unit is powered down.  
 
When the Dash 2EZ+ is powered up it will load any global file setup named “defaults” saved in the system memory.  
The user can save their favorite setup as “defaults” and the system will load it each time the Dash 2EZ+ is powered on. 
 
The user can also Save and Load many different user setups on the CompactFlash® card and/or in System memory. 
 
ACTION HOW TO  (Save Global Settings Files) 
 
Save Global 
Settings 
File 

 
 
 
 
 
 
 
 
 
 
 
 

 
 

Save Setup 
and Save 

Icon 

 
Choose the Menu icon. The Menu screen will open. 
 
Select the Save Setup icon. The Save Setup file screen will open. 
 
Select Global Settings Files from the file type list. 
 
Select a destination drive for the file. 
         • To save the file to the system drive, select the System option. 
         • To save the file to the CompactFlash card, select the Card option. 
 
Note: Before the Dash 2EZ+ can save setup files to the Compact Flash card, a formatted 
CompactFlash card must be inserted. Instructions on formatting the CompactFlash card are 
presented in the Sample Exercise section 13 of this Quick Start guide. 
 

Save Icon 
Save Destination Drive

(System or Card) 

File Name List 

Save Settings File Type 
Pull Down list

 
 

Dash 2EZ+ Save Settings File Menu 
 
Choose the file name field above the file list. A keypad will appear. 
Enter a name for the file and choose the OK button. The specified file name will appear in the field. 
 
Choose the Save button. The global settings file will be saved. Global settings files are saved with the 
“.GBL” file extension. Press X to exit the Save Setup menu. 
 
Caution: While a file is being saved, the message “Writing File” will be displayed below the drive list. Do 
not remove the CompactFlash card or turn the power off while this message is displayed. Turning the 
power off or removing the card while data is being written to it may result in data loss. 

Continued…



ACTION HOW TO  (Load Global Settings Files) 
 
Load 
Global 
Settings 
File 
 
 
 
 
 
 
 
 
 

 
 

Load/  
Load Setup 

Icon 

 
Choose the Menu icon. The Menu screen will open. 
 
Select the Load Setup icon. The Load Setup file screen will open. 
 

Load Icon Load Drive 
(System or Card)

File Name List 

Load Settings File Type 
Pull Down list

 
 

Dash 2EZ+ Load Settings File Menu 
 
Select Global Settings Files from the file type list. 
 
Select the drive that contains the file. 
• To load the file from the system drive, select the System option. 
• To load the file from the CompactFlash card, select the Card option. 
 
Select a file from the file list. 
 
Choose the Load button. 
The Global Settings File will be loaded. Press X to exit the Load Setup menu. 
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1111..    IINNTTEEGGRRAATTEEDD  CCHHAARRTT  RREECCOORRDDEERR  
  

The high-resolution strip chart recorder can print Realtime or Review (captured) waveforms. The printed waveforms will 
correspond to the waveforms on the display. If the frequency of a waveform is too high for the printer to print effectively, 
the waveform will print as a light gray band.  
 
ACTION HOW TO  (Run and Halt the Printed Chart)  
 
Run/Halt 
the 
Integrated 
Chart 
Recorder 

 
Press the Chart Run/Halt icon in either Realtime or Review mode to run/halt the chart. If the Chart/Halt 
icon is not in your control panel, please see section 4 of this Quickstart guide for instructions on adding 
icons to the Dash 2EZ+ control panel. 

                                                               
 

                                                          Chart Run/Halt Icon 
        

The Realtime mode chart prints channel labels and text buffers as defined by the user. The chart also prints the date, 
time and real-time chart speed. 
 

Channel 1&2 
Text 

Buffers

System
Text 

Buffer

Channel Label 
and Amplifier 

Settings

Date 
and 
Time

Chart Speed

 
 

Dash 2EZ+ Example of Realtime Mode Chart  
 

The Review Mode chart prints the same information as defined by the user in Realtime Mode with one convenient 
addition. The Review Mode chart provides the user with a printout of the effective chart speed. The effective chart speed 
predicts the equivalent Realtime speed of the printed chart to achieve the time scale. The effective chart speed is also the 
reciprocal of the time scale. 
 

Channel 1&2 
Text 

Buffers

System
Text 

Buffer

Channel Label 
and Amplifier 

Settings

Time Scale

Effective
Chart Speed

Record name with Date
 

 
Dash 2EZ+ Example of Review Mode Chart 
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1122..  EENNTTEERRIINNGG  EENNGGIINNEEEERRIINNGG  UUNNIITTSS  
 
Engineering Units provide the capability to display user-selected units instead of voltage. All signal information enters the 
Dash 2EZ+ as voltage. However, converting the voltage unit to an alternative unit of measure may be desirable in 
applications that measure current, pressure, strain, or any non-voltage unit. This allows the Dash 2EZ+ to be compatible 
with transducers and probes that can provide a voltage output to the Dash 2EZ+. The relationship between the voltage 
and the engineering unit is assumed to be linear, characterized by a slope and offset (y = mx + b). 
 
The following is an example of entering engineering units into the Dash 2EZ+. For this example, we will assume we are 
entering the engineering units for a current probe that provides a 100mV/A voltage output to the Dash 2EZ+. 
 
The ACTION on the left-hand side describes the function.  The HOW TO section provides the detailed steps to take using 
the Control Panel and Amplifier Setup menu. 
 
ACTION HOW TO  (Enter Engineering Units)  

 
Enter the 
Amplifier 
Setup 
Menu 

 
Select 
Channel 
and 
Enable 
Units 

 
 
 

Set 
Precision, 
Scale, 
Units and  
Offset 
 

 
 

 

 
Choose the Menu icon. The Menu icon is located at the top right hand side of the D2EZ+ touchscreen. The 
Menu screen will open. 
 
Choose the Amplifier Setup icon located in top left hand corner of the main Menu. The Amplifier Setup 
menu will open. Choose the Units tab to display engineering units options. 
 
Select the Channel to set up from the channel pull down list. 
 
Check the Enable option located at the bottom of the Units tab to enable engineering units for the selected 
channel. 
 
Choose the Precision field. A number pad will appear. Enter a Precision value for the engineering units to 
indicate the number of decimal places that will be used. You can specify up to six decimal places. For this 
example, enter “3”. 
 
Choose the Scale field. A number pad will appear. Enter the waveform change in engineering units that is 
equal to one module unit. Then choose the OK button. 
 
Choose the Units field. A keypad will appear. Enter a name (display label) for the units. For our example, 
AMPS would be an appropriate label denoting current. Then choose the OK button. 
 
Choose the Offset field. A number pad will appear. Enter the number of module units that is equal to zero 
engineering units. For this example, Offset is not needed. Choose the “X” button to exit the Offset menu. 
 
Choose the OK button to complete the engineering unit setup process. Select the Goto Realtime icon to 
return to the Realtime screen. 

The Scale equals one engineering unit per one module unit. 
For example: Current probe MN255 (accessory part number 24661300) has a 100mV/A setting 

for the 20A measurement range. 
Using the HV-EZ+ isolated voltage module 

the scale would be 10 (10V per AMP) and the units would be entered as AMPS.

The user can set an offset on 
the measurement if required.

The user can set the number 
of decimal places to be used 

(up to six).

The user must check the “Enable” box to activate 
the Engineering unit settings entered.  

 
The Units section of the Dash 2EZ+ Amplifier Setup Menu  



 16

1133..  SSAAMMPPLLEE  EEXXEERRCCIISSEE  
 

In the following hands-on exercise, you will set up a channel to monitor a 9 Volt battery in Realtime.  Next, a data capture 
initiated with an Analog trigger will be set up to record when the battery voltage is applied.  Finally, the captured data will 
be reviewed and a portion will be printed using the integrated chart recorder. 
 
Items Needed: 9 Volt battery. Signal input leads and a Dash 2EZ+ with at least one HV-EZ+ module. For this example 
we will assume Channel 1 is installed with an HV-EZ+ module. 

  
The ACTION on the left-hand side describes what is to.  The HOW TO section provides the detailed steps to take using 
the Control Panel and various setup menus. 
  
ACTION HOW TO  (Set the Channel 1 Amplifier Setup for this Exercise)  
 
Turn On the 
Dash 2EZ+ 
 
Enter the 
Amplifier 
Setup Menu 
 
Disable 
engineering 
units 
 
Disable 
Filters 
 
Select  
Channel 1 
 
Choose 
Attenuator 
 
Set Channel 1 
Span & 
Bottom 
 
Edit Channel 
Label 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Return to 
main Menu 
 

 
Turn on the power switch located on the right hand side of the Dash 2EZ+.  
 
 
Enter the main Menu by selecting the Menu icon located at the top right hand corner of the Control 
Panel. Enter the Amplifier Setup menu by selecting the Amplifier Setup Icon on the main Menu 
screen. The Amplifier Setup screen will open.  
 
Select the Units tab on the top of the Amplifier Setup screen. Make sure the Enable box at the bottom 
of the Units tab is not selected (no check mark). We do not want engineering units enabled. 
Engineering Units will be covered in section 12 of this quick start guide. 
 
Select the Filters tab on the top of the Amplifier Setup screen. Make sure the Filter type for Channel 1 
is Off. 
 
Select the Amplifier tab on the top of the Amplifier Setup screen. Select Channel 1 from the Channel 
pull down list. 
 
Select the 5 – 700 V attenuator from the Attenuator pull down list. 
 
 
Select the Span and enter “10”. Select the Bottom and enter “0”. 
 
 
 
Select the Edit Label icon located in the bottom right hand corner of the Amplifier tab of the Amplifier 
Setup menu. Enter Channel 1 9V Battery and press OK. 
 

 
 

Example of the Amplifier Menu / Amplifier tab for this Sample Exercise 
 
Press the OK icon located in the bottom left hand corner of the Amplifier Tab of the Amplifier Setup 
menu to return to the Realtime screen.  

Continued…
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ACTION HOW TO  (Set the Channel 1 View Setup for this Exercise)  
 
Enter the 
Format tab 
of the View 
Setup Menu 
 
Set Channel 1 
View  
 
Remove 
Channel 2 
(Note: Channel 2 
is not used in 
this exercise) 
 

Set Chart 
Speed 
 
Enable Print 
Halt 
 
 
 
 
 
 
 
 
 
 
 
 
Enter the 
Colors tab 
of the View 
Setup Menu 
 
Set Channel 
Colors 
 
Set Print 
Darkness 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Exit View 
Setup Menu 

 
Enter the main Menu by selecting the Menu icon located at the top right hand corner of the Control 
Panel. Enter the View Setup by selecting the View Setup Icon on the main Menu screen. The View 
Setup screen will open. Select the Format tab on the top of the View Setup screen.  
 
 
Select 1 Grid from the grid pull down menu. The grid pull down menu is located under the Format tab.  
Under Grid Divisions enter “6” for Channel 1, we will not use Channel 2 in this exercise. Enable the 
Grid Minors by selecting Minors. The Minors selection box should have a check mark once selected. 
 
Under Pen Lift select Channel 2 to enable the Pen Lift on Channel 2. The Channel 2 Pen Lift selection 
box should have a check mark once selected. We are lifting the pen on Channel 2 because we will not 
use Channel 2 in this sample exercise. Channel 1 Pen Lift should not be selected. 
 
In the Speed section enter “25” in the number section and select mm/s from the Speed Unit Pull down 
menu.  
 
In the bottom left hand side of the Format tab, select Print Halt. The Print Halt option selection box 
should have a check mark once selected. The Screen Halt option is located above the Print Halt 
selection. The Screen Halt option should not be selected. 
 

 
 

Example of View Menu / Format tab for this Sample Exercise 
 
Select the Colors tab on the top of the View Setup screen. Under the Item pull down list choose 
Channel 1. Under the Color pull down list choose Blue.  
 
The Print Darkness slide bar is located at the bottom of the Colors tab. Slide the Print Darkness slide 
bar all the way to the right. 

 
 

Example of View Menu / Colors tab for this Sample Exercise 
 
Press OK in the bottom left hand corner of the Colors tab to return to the main Menu. 
 

Continued…
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ACTION HOW TO  (Format the Compact Flash card)  
 
 
 
 
 
Format 
Compact 
Flash Card 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Apply Icon 
 
 
 
 
 
 
 
 
 
 
 
 
 

Exit System 
Setup Menu 

 
Before the user can input Capture Setup functions or capture data, a formatted CompactFlash 
card must be inserted. The following are instruction to format a Compact Flash card for use with 
the Dash 2EZ+ 
 
Insert a Compact Flash card into the Compact Flash port located on the left hand side of the Dash 
2EZ+. 
 
Enter the System Setup by selecting the System Setup Icon on the main Menu screen. The System 
Setup screen will open. Select the General tab on the top of the System Setup screen.  
 

 
 

Example of the System Setup Menu tab for this Sample Exercise 
 
Select the General tab found at the top of the System Setup menu. 
 
On the General tab input “98” into the percentage filed located in the Card Format section of the 
General tab. We are setting 98% of the card to be designated for capturing data. The other 2% can be 
used to save setup files. 
 
WARNING: Formatting the CompactFlash card will erase all current data on the CompactFlash 
card. 
 
Press the Apply icon located to the right of the percentage field in the Card Format section of the 
System Setup / General tab. A dialog box labeled “Card Format” will appear asking “Are you Sure?”. 
Press OK on the Card Format dialog box. You will see the text “Format in Progress” at the bottom of the 
General tab until the card has completed the format. This should take a few seconds. 
 

 
 

Example of the System Setup / General tab for this Sample Exercise 
 
When the CompactFlash card has completed formatting, press the X in the left hand corner of the 
General tab to return to the main Menu. 
 

Continued…



ACTION HOW  TO  (Set a 10 second Capture with 2 seconds of Pre-trigger for this Exercise) 
 
Enter the 
Capture 
Setup Menu 
 
Enter a 
Capture  
Base 
Filename  
 
Enable 
Channel 1 to 
be captured 
 
Set the 
Sample Rate 
 
 
Set the 
Capture 
length 
 
Set the  
Pre-Trigger 
length 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Exit Capture 
Setup Menu 

 
Enter the Capture Setup menu by selecting the Capture Setup Icon on the Menu screen. The Capture 
Setup screen will open.  
 
 
Select the Base Filename section located at the top of the Capture Setup menu. A keypad will appear. 
Enter “9V Battery” on the keypad and press OK. The Base Filename “9V Battery” should be seen in 
the Base Filename area.  
 
 
Under the Channel Enable section of the Capture Setup menu, enable Channel 1 by selecting it. The 
box to the left of Channel 1 should be checked. Deselect Channel 2 and the Event. The box to the left 
of Channel 2 and the Event should not be checked. 
 
Select 1000 from the Sample Rate pull down list.  
 
 
Select Seconds from the Data Capture length pull down list.  
 
Select the box under the Data Capture Length pull down list. A keypad will appear with Seconds listed 
at the top. Enter “10” into the keypad and press OK. 
 
Select the box under the Pre-Trigger section. A keypad will appear with Pre-Trigger listed at the top. 
Enter “2” into the keypad and press OK. 
 
The No Trigger, Auto Rearm and Auto Review boxes located under the Pre-Trigger box should not 
be checked. 
 

 
 

Example of the Capture Setup menu for this Sample Exercise 
 

The Dash 2EZ+ is now set to record a capture once a trigger has been applied. The capture length will 
be 10 seconds of which 2 seconds will be pre-trigger data. 
 
Press OK to enter the main Menu. 

 
Continued…
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ACTION HOW TO  (Set an Analog Trigger and prepare final steps for data capture) 
 
Enter the 
Trigger Setup 
Menu / 
Analog tab 
 
Select 
Trigger Type 
and Level 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Exit Trigger 
Setup Menu 
 
Add “Arm 
Capture” icon 
to the Control 
Panel 
 
 
 
 
 
Save system 
settings 
 
Enter 
Realtime 
mode 

 
Enter the Trigger Setup menu by selecting the Trigger Setup Icon on the Menu screen. The Trigger 
Setup screen will open. Select the Analog tab at the top of the Trigger Setup menu. 
 
 
 
Select Rising from the Channel 1 trigger pull down list. Once Rising is selected a Level box will appear 
below the Channel 1 trigger pull down list. Select the Level box, a keypad will appear with Level listed 
at the top. Enter “5” and press OK on the Level keypad. 
 

 
 

Example of the Trigger Setup / Analog tab for this Sample Exercise 
 
Press the OK icon located at the bottom left hand side of the Analog tab of the Trigger Setup menu. 
The unit will return to the main Menu. 
 
Using the Control Panel instructions found in section 4 of this quick start guide, add the Arm Capture 
icon to the Control Panel of the Dash 2EZ+ Realtime screen. Place the Arm Capture icon under the 
Menu icon. 

 
 

Arm Capture icon 
 

Using the instructions found in section 10 of this quick start guide, save your system settings to the 
Compact Flash card. Name your settings 9V Battery. 
 
 
Enter Realtime mode through the main Menu. Your Dash 2EZ+ screen should look like the example 
below. 
 

 
 

Realtime screen for this Sample Exercise 
Continued…
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We now have the Dash 2EZ+ set to record 10 seconds of data (2 seconds of pre-trigger, 8 seconds of post-trigger) once 
the 9V Battery is connected to Channel 1. We will now Arm the capture, connect the 9V Battery and activate our post 
capture trigger. 
 
ACTION HOW TO  (Arm the capture and record the 9V Battery) 
 
Connect the 
test leads. 
 
Arm the data 
capture 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Connect the  
9V Battery to 
start the post 
trigger 
capture 
 
 
 
 
 
 
 
 
 

 
Connect the test leads to Channel 1. Do not connect the 9V battery at this time. 
 
 
Press the Arm Capture icon that was added to the Control Panel in the previous section. The text 
Capturing Pre-Trigger will appear for 2 seconds at the bottom of the Realtime screen. 
 

 
 

Arm Capture icon 
 

 
 

Realtime screen with “Capturing Pre-Trigger” text for this Sample Exercise 
 

 
The unit is now using the circular buffer to capture the 2 seconds of Pre-trigger, the unit is now waiting 
for Channel 1 to pass above 5V to initiate the software trigger set in this exercise for post capture 
recording. 
 
 
Connect the 9V Battery to the test leads. The post capture will now begin. The text Capturing Post-
Trigger will appear for 8 seconds at the bottom of the Realtime screen. 
 

 
 

Realtime screen with “Capturing Post-Trigger” text for this Sample Exercise 
 
 

Continued…



We will now Review the 9V Battery capture we just recorded. 
 
ACTION HOW TO  (Review 9V Battery Capture) 
 
Enter 
Review 
Mode 
 
Select 
Review File 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Compress 
Data to 
screen 

 
Enter the Review mode by selecting the Go to Review icon on the Menu screen.  
The Review mode file selection screen will open.  
 
 
Highlight the 9V Battery file and press the OK icon in the lower left hand corner of the Review mode file 
selection screen. The 9V Battery capture will load and display the record. 
 

                              
 
        Review Mode file selection screen                            Review Mode screen with 9V Battery record 

 
Dash 2EZ+ Review mode files load at full expansion. To compress the file, select the 
Compression/Expansion button (x1 button), the Compression/Expansion keypad will appear. 
 
Select Set Compression and then select OK on the Compression/Expansion keypad. The 
Compression keypad will open. Enter 40 in the Compression keypad and then press OK.  
This file is small enough to be compressed to the Dash 2EZ+ screen (as shown below).  
 

 
 

9V Battery record with x40 Compression 
 
 

                                                      Continued…
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ACTION HOW TO  (Make Cursor Measurements in the 9V Battery Capture) 
 
Make Cursor 
Measurement 
 
 
Enable 
Cursors 
 
 
 
 
Select 
Measurement 
and Time 
type for the 
Cursors 
 
Place 
Cursors and 
observe 
measurement 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Enter the View mode by selecting the View icon on the Menu screen.  
The View mode file selection screen will open. Select the Measure tab. 
 
Enable Cursor A and B by selecting the box to the left of the Cursor A and Cursor B text on the View / 
Measure tab. The box will be checked once enabled. 
 
Note: A faster method of showing the cursors involves adding the Cursor A and Cursor B buttons to the 
control panel. This will provide the capability to quickly show/hide cursors without 
leaving the waveform display screen. 
 
Select Maximum-Minimum from the Type pull down menu, select Absolute Time from the Time pull 
down menu. 
 
Press OK in the lower corner of the View / Measure tab, you will be returned to the same review screen 
you left when you entered the View menu. 
 
Drag and place Cursor A to the left of the 0-9V transition and then drag and place Cursor B to the right 
of the 0-9V transition as shown below. Note the Maximum-Minimum measurement in the top right hand 
corner of the waveform viewing area, the Absolute Time and time difference below the waveform 
viewing area. 
 

 
 

9V Battery record with cursor measurements 
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ACTION HOW TO  (Print 9V Battery Capture) 
 
Print record  

 
1. Choose the status text area. This area is indicated in the following illustration. 
 

 
 

Status Text Area 
 
The print options will appear. 
 

 
 

Dash 2EZ+ Review Mode Print Options 
 
 

If necessary, use the Print Enable option to enable/disable the printer. 
 
2. Select the print options. 
• To print the entire data capture file when the printer is enabled, select 
the All option. 
• To print the page currently on the display when the printer is 
enabled, select the Page option. 
• To print the area between Cursors A and B when the printer is 
enabled, select the Cursors option. 
 
3. To print the chart using the current compression/expansion, check the 
Compression option. Uncheck this option to print the standard size (x1 without Compress). 
4. Choose the OK button to complete the printing setup process. 
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1144..      PPOOWWEERRIINNGG  DDOOWWNN  
 
When the power switch is set to the off position, the Dash 2EZ+ begins the power down sequence. The power down 
sequence is indicated by the green LED found on the right hand side of the unit next to the power switch. The LED will be 
on while the power down sequence occurs. Note that the LED will either be a solid green or it may flicker.  It is very 
important not to turn the power switch back to the on position during the power down stage. The Dash 2EZ+ recorder 
must be allowed to complete the power down sequence to insure proper operation. 

This completes the Dash 2EZ+ Quick Start Guide.  Please note that the Dash 2EZ+ has much more capability than 
presented in this guide.  Please see the Dash 2EZ+ Operations Manual (Part Number 22834552) for additional details.  
Should you require additional assistance, you can contact our Technical Support Department toll-free at 877-867-9783 or 
by e-mail: techserv@astromed.com 


